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SCAL6 Tracing Examples Expanded Tutorial 
 

• This tutorial contains examples of the various trace options and settings presented in the SCAL6 User 
Manual. 

 
 

5.03.2 Monochrome Trace of a Colored Image: Effects of Contrast 

• Start by clicking on Choose an image in the Input section and then browse to locate the raster file you wish 
to trace: 

 

• In this example, a bell pepper image is imported for tracing and the Preview indicates a single trace path 
around the image: 

 

 

• Let’s experiment with the Contrast setting to fully understand how it works on an image of this type. Note 
that as you drag the Contrast scroll bar, the original image disappears so that you only see the trace lines: 
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• Thus, for any given image, scroll the Contrast setting to see the effects and determine which version best 
suits your project needs. Once satisfied, click on OK and the image will appear in the top left corner of the 
Cutting Mat, ready to be resized and cut out: 

 
 

 

5.03.3 Monochrome Trace of a Silhouette Image: Effects of Smooth 

• As mentioned at the end of Section 5.02, silhouette images typically offer an easy trace. In this next 
example, a silhouette cat image is imported into the Trace Image window. Because this is a silhouette 
image, Monochrome mode is chosen and the image appears to have traced very well. However, upon a 
closer look at the right side of the cat, it appears that the neck area is a bit sharp: 

                     

• To soften the outline of the cat, zoom in on that area and then increase the Smooth setting until a desired 
result is obtained. In the following screenshot, the Smooth setting is increased from 75 to 85. Remember to 
click on Update Preview after every adjustment to settings: 

 

    

• After clicking on OK, the cat shape appears on the Cutting Mat and is ready to be sized and cut: 
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5.03.4 Monochrome Trace of a Detailed Image: Effects of Despeckle and Detail 

• Either the Despeckle option or the Detail setting can be used to filter out small shapes. Sometimes these 
shapes are just random pixels that show up from, say, a dirty scanner bed. Other times they are shapes that 
make up the design but will be too small to cut and are not needed. 

• Before showing examples, note that there will be times when some small shapes might be needed but not 
all of them. In those situations, it’s best to include them and then they can be edited out using other tools in 
SCAL. 

Despeckle 

• Since Despeckle is simply an on/off option, it makes sense to try it first when you see a lot of tiny unwanted 
shapes being included in the trace.  For example, with the following clipart image of an angel fish, tiny 
specks surround the image in the Preview: 

 

 Marking the option for Despeckle and clicking on Update Preview, removes the specks and the image 
is ready to import: 

 

         

 

Check the Despeckle option 
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Detail 

• The Detail setting allows one to control the size of the small shapes that are eliminated. 

 The following tree image is imported into the Trace Image window. You have decided that not all of the 
leaves are needed.  The Detail setting can be lowered to filter out some of the smaller ones: 

                   

 

 Even with Detail set at 0, there are still shapes of a certain size in that particular image that will be 
included in the trace. Again, there are editing tools that can be used in case more of the small shapes 
need to be removed. Refer to Section 6.06 on using the Eraser or Section 3.12.1 on Break Apart. 

• Note that if Despeckle had been applied to the tree image, instead of deleting the smaller shapes, it would 
have included them in the trace: 

   

 

 This result indicates that when the small shapes are extremely close to a large shape, they will become 
part of that larger shape instead of being filtered out. 

  
 

5.03.5 Monochrome Trace of a Coloring Book Image: Single Line Threshold and Blackout 

• The Single Line Threshold setting is useful when the imported image had a black border around it and you 
do not want a double line trace. For example, if the following T-shirt image is traced using default settings, 
two trace lines result: one line is following the outside of the black border while the other line is following the 
inside of the black border: 

   

 

 

• To have only one trace line, increase the Single Line Threshold setting until there is only a single line 

Detail: 95 Detail: 50 Detail: 25 Detail: 0 

Original image Trace of image 

Despeckle: Off Despeckle: On 
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showing in the Preview window: 

     

 

 

 Because the T-shirt image is a simple closed shape, the Blackout option could have been used instead 
of Single Line Threshold: 

   

 

 However, if the T-shirt had internal details, such as a pocket, then Blackout could not be used as the 
entire pocket would have been ignored. In this situation, Single Line Threshold is the better choice: 

        

 

 

 

 

5.03.6 Monochrome Trace of a PNG File with a Transparent Background 

• PNG files with a transparent background are the easiest files to trace because the software can readily 
identify where the invisible background starts and ends. Also, if you know in advance that the PNG file has a 
transparent background, you can forgo the Trace Image window and use File>Import (or drag and drop) 
instead. You still have the option to trace the Print layer by selecting it only and going to the Trace Image 
window. Refer to Section 5.03.2. 

• If, on the other hand, you wish to import the PNG file after opening the Trace Image window, then activating 
Use Alpha Channel will indicate if the PNG file’s background is transparent or not:  
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• If the image turns out to have a background color, such as with the bird above, then unmark the Use Alpha 
Channel option and proceed with the trace using the details from Section 1 of this tutorial.  Otherwise, as in 
the case of this cow image, the trace line is automatically set, thus adjusting Contrast will have no effect on 
the trace. 

• Because this is a print-and-cut application, you might want to set an Inset so that the cut line will be inside 
the auto-generated cut line. This will help prevent any extra white showing around the cut. Or you might 
want a contour cut line added whereby you’re deliberately cutting a white border around the image: 

 

     

 

 

• IMPORTANT:  Don’t forget to also enable Add Image Layer (Print+Cut) so that the imported PNG image 
will also be transferred to the Page once you click on OK. More on the results of this assigned are covered 
in the following Section 6. 
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5.03.7 Monochrome Trace for a Print and Cut Application: Effect of Resample  

• In many print and cut applications, a raster image is imported with the intention of printing that image and 
then cutting precisely along the edges of that image. For this reason, it’s very important to get as accurate of 
a trace as possible. 

• The Resample setting multiplies the number of pixels in the image allowing a more precise scan of the 
border between the image and the background color.  The following image is imported and traced with the 
default of x 1.0 left as the Resample setting.  

 

• Before clicking on OK, note two settings that have also been marked: 

 Blackout: apply if there are internal cut lines that are not needed. In this example, only the outside of 
the penguin needs to be traced. Thus, applying Blackout will remove the internal cut lines showing in 
the Preview: 

    

 

 

 

 Add Image Layer (Print+Cut): Mark this box so that the original image is also imported onto the 
Cutting Mat. Note that if you check the Style Panel settings on each layer, one will be assigned as 
(Print+Cut) Cut Only (layer can only be cut, not printed) and the other will be assigned as (Print+Cut) 
Print Only (layer can only be printed, not cut). Click on OK and the following layers appear: 

Cut Layer Assignment 

Select 
Monochrome 

Resample is 
left at x 1.0 

Preview  

Preview of trace with Blackout not 
checked. Note the internal red 

lines that would be cut. 

Preview of trace after Blackout is 
checked. The internal red cut lines 

are removed. 
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Print Layer Assignment 

 

• Returning to the Resample setting, the same image is traced again, but the Resample will be set at a 
maximum value of x4: 

 

.  

• If you compare the Preview in both cases, there doesn’t appear to be a difference in the trace. However, if 
you select the Print + Cut Cut layer on the Layer Panel and change the Stroke to a bright color and then 
zoom in closely, you can clearly see places where the x 4.0 Resample resulted in a tighter fit: 

Select 
Monochrome 

Resample is 
changed to 
x 4.0 Preview  

Select Cut layer 

Will only cut 

Select Print layer 

Will only print 
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• In Section 2, it was shown how the Smooth setting affects the trace line. This setting can also be tested 
on PNC tracings as a way of getting a better fit, by decreasing the value.  Alternatively, you can also 
create an Inset after the trace, if needed, to create a path that will cut just inside the image. Refer to the 
Inset Offset option covered at the end of the previous Section 5. 

 

 

5.03.8 Resample Versus Smooth and the High Pass Filter 

• In many respects, the Resample setting appears to have the same effect as the Smooth setting. However, 
the Resample is applied to the imported raster image ahead of tracing, while the Smooth setting is applied 
to the actual trace lines.  

• While there is no definite way of knowing which setting to use in any given tracing, keep in mind the 
following: 

 The purpose of Resample is to help the tracing algorithm “see” more pixels and provide a tighter, more 
precise trace.  

 The purpose of the Smooth setting is to make the trace less angular or more angular. Thus, the 
Smooth setting would probably be set high when tracing something like a stuffed toy but set very low 
when tracing something like a box pattern with lots of right angles.  

• In general, you’ll just need to test them to see which one is better or if applying both is the best option.  

• In the example below, it will be shown that Resample improves the accuracy of the trace over Smooth.  

 

 Using a Resample of x 1.0 and other settings set (which will again be used when Smooth is tested), 
the trace results in the following. Since an important focal point would be on the boy’s face and hat, note 
that the resulting trace isn’t as sharp as one might want: 

X 1.0 Resample X 4.0 Resample 
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 By increasing the Resample to x 2.0, the shape of the hat and the face become closer to the original 
image: 

    
 
 
 

 On the other hand, if one leaves the Resample at x 1.0 and, instead, decreases Smooth from 75 to 70, 
the hat becomes too pointed/angular without improving the shape of the face: 

 

    
   
 
 

 Thus, in this particular example, increasing the Resample had a more desirable outcome than 
decreasing Smooth.  

 Another setting, called the High Pass Filter, can even further sharpen a tracing. When it was applied in 
this same example, note the remarkable improvement in detail:   

 

 

 Based on my initial experience, there are two downsides to using this setting: 

X 1.0 (None) Resample X 2.0 Resample 

Smooth = 75 Smooth = 70 
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o Getting the optimum setting in combination with the Resample and Contrast settings, is tricky 

o After applying and getting the trace onto the Cutting Mat, you’ll need to apply Object>Break Apart 
and eliminate some unwanted paths. Alternatively, you can use the Draw Mask option to edit while 
still in the Trace Image window. Refer to Section 10. 

 For more details on the High Pass Filter, refer to Section 11. 
 
 

5.03.9 Color Layers Trace  

• As mentioned in Section 5.03.1, Color Layers might be a good mode to choose for a paper piecing or 
layered vinyl project if you want under-layers present. In this section, a flower that has two shades of pink 
and two shades of green is chosen: 

 

• After loading the image and then selecting Color layers, the window will update to show new settings:  

 

• The Max Colors setting shows the current number of identified colors. Below that are icons of these colors. 
Note that white (or whatever has been used for the background color of the graphic, will also be included in 
the count. If you do not see those color samples, click on Color layers a second time.  

• Depending on the image and what you want in your final trace, the Max Colors can be increased or 
decreased. Because this image has two shades of pink and two shades of green, those can be added to the 
count:     

 

Select Color layers 

Click here after 
every change 

Scroll to the left to 
better see the cut 
lines in the Preview 

Scroll to select 
number of colors 
to identify 

Colors identified 

Preview 

Max Colors 
increased to 6  
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• After accepting OK in both cases, the layers are ungrouped and compared: 

    

 

       

• You can also turn off colors by clicking on them. For example, if you do now want the black background 
traced: 

 

• The result is this: 

    

• A useful application for the Color Layers trace option is converting a photo (or another image) into a 
contoured cut project. Thanks to Leslie Merriett for sharing this project: 

                                

Max Colors = 4 produces 3 layers 

Max Colors = 6 produces 5 layers 

Click once on a 
color to remove it 
from the trace  

Original Photo Color Layers Trace 
Max Colors: 7 

After darkest layer 
expanded to fill 

background 
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5.03.10 Single Color Trace  

• With the Single Color option, each desired color is selected and traced individually. The advantage is that 
only the visible part of each color is traced.  The disadvantage is that it takes a bit more effort. 

• Again, the same flower image that was used in the prior section will be opened into the Trace Image 
window.  When Single Color is selected from the drop-down menu, the window will update to show new 
settings: 

 

 

• Mark the option for Prompt to continue tracing. After you import each color to the Cutting Mat, the Trace 
Image window can be kept open to trace the next color. 

• In the screenshot, the initial color identified was a shade of green. In the Preview, you can see how many 
parts of the flower were included as being in the range of that shade.   

• If you want to add more of the green parts of the flower, then increase the Contrast. As you hold down the 
left mouse button and scroll, the image will turn gray so that you can more clearly see what is being added. 

 With a Contrast of 26, the outline of the flower stem and leaf appear: 

Select Single Color  

Click here after 
every change 

Scroll to the left to 
better see the cut 
lines in the Preview 

Increase Contrast 
to add similar colors 
to selection 

Current color 

Preview 

Mark this box 

After cutting and assembling 
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 With a Contrast of 41, the leaves and stem fill: 

 

• Once you are satisfied, click on OK and you will be asked if you wish to continue tracing. Answer Yes: 

 

• Click on the color box next to Single Color. A message will pop up indicating you are to click on another 
color on the Preview: 

 

• One of the petals is clicked and the color box turns to that color.  The Preview shows how much of the 
image is now included at the current Contrast of 5: 

 

 

• The process is then repeated whereby the Contrast is increased. At a value of 30 more of the same petals 
are filled out, thus it is recommended to always tweak the Contrast some: 

Contrast = 26  

Outline of leaves and 
stem appears 

Click on this box 

Contrast = 41  

Leaves and stem fill 
with color 

These petals are 
included in this color 

Newly selected color 

Contrast = 5 

Click on Yes so that Trace Image 
window remains open and another 
color can be traced. 
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• If the Contrast is increased even higher, the center part of the flower gets added.  Just as in the case of 
using Color Layers, this is optional.  

 

 

• After deciding on the Contrast for pink, click on OK.  Now, let’s assume that you did the petals and center in 
two parts and you are now at this point: 

 

• You now have several options for completing the trace which involves adding a final outline/shadow 
layer to the flower: 

 Continue to use Single Color, click on the part of the image that is black, mark the Blackout 
option: 

 

 Switch to Monochrome mode, mark the Blackout option:  

Contrast = 45 
The center of the 
flower is now added 

Contrast = 30 
The petals fill out a bit 
more at a higher 
Contrast 



16 
 

 

 Forgo using the Trace window. Select the layers traced so far and use the Shadow Layer function 
to add a black outline. Details of this procedure are covered in Section 7.23. 

• The final results, using the three options, are virtually identical:  

 

 

5.03.11  Draw Mask Function 

• In the Output section of the Trace Image window, under Edit Mode is a Draw Mask option which can be 
used to erase or add to a trace. With some images, finding the trace optimum settings can be tricky.  You’ll 
end up with some parts not quite traced and, perhaps, other parts not needed. This function allows you to 
“complete the task.” 

• When Draw Mask is selected, another option menu appears: 

  
Mask/Foreground:  This option allows you to freely draw shapes to be added to the trace. For example, in the 
prior screenshot, you’ll observe that the fishing pole line is not completely traced: 
 

 

A Size setting and options for either 
Mask/Foreground or 
Mask/Background appear 

Select Draw Mask 

Line is not 
complete  
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 Zoom in using the Zoom In icon and change the Size setting until the circle ~ matches the size of the 
fishing line. In this instance, the minimum of 1 will work best because the fishing line is so thin:  

 

  Drag the mouse along the image where the fishing line wasn’t trace. A pale green path appears: 

   

 Click on Update Preview. The added paths will be automatically welded to the part of the fishing line 
that was traced: 

 

• Background:  This option allows you to erase anything that’s not wanted in the current tracing. For 
example, the bird just to the right of the tree, can be removed.   

 As before, zoom in and set a Size for the tool: 

 

 

 

 

 

 

 

 

Click here to zoom in  

Draw tool  

Set the Size of the tool  

Tool is dragged 
along here… 

…and then along here  
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 Drag the mouse across the image of the bird and the green shading indicating a traced image will begin 
to be erased. Continue until there’s no longer any green: 

    

 

 Click on Update Preview and the red outline and green fill of the bird is now gone: 

 

 

• Click on OK and the resulting changes from both masks have been applied: 

Click here to zoom in  

Erase tool  

Set the Size of the tool  

Drag mouse to 
erase the green  

Continue until all of 
the green inside the 
bird is removed  
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5.03.12  High Pass Filter Application 

• The High Pass Filter setting is used to improve the tracing of photographs and other challenging images.  
The setting ranges from 0 to 20. 

Improved Detail 

• In the following example, the first image is with High Pass Filter turned off. The subsequent images show 
what happens as the High Pass Filter is set a 0, 1, 10, and 20.  Obviously, none of these appear to be what 
you would want: 

    

                    

• The first step is to lower the Contrast back to the default setting of 127. The High Pass Filter setting is 
then set at 1 and a double trace line appears.  As High Pass Filter is increased, the internal lines start to 
diminish: 
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• However, with too high of a setting, new tracings may also begin to appear: 

 

• At this point, you can try adjusting the Contrast. However, if you are satisfied with most of the trace lines, 
you can then use the Draw Mask function, covered in Section 10, to erase these extra unwanted lines and 
to fill in any areas within the image. The final result: 

 

 

Converting a Photo to a Digital Stamp 

• The High Pass Filter setting will allow a much better conversion of a photo to a black and white image. The 
following photo of a rose will be used as the example: 

 

• The best monochrome tracing without using the High Pass Filter required tracing in stages: one to get an 
overall outline, another to get the internal details of the rose, and a third to get the internal details of the 
leaves.  
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• Object>Merge was then applied and the resulting traced image looked like this: 

 

• Instead of using three separate traces, the High Pass Filter could have been set instead: 

    

• Obviously, it was not only quicker to simply apply the High Pass Filter, but the results turned out much 
better. 
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